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ABSTRACT 

This set of instructions for producing a proceedings paper for the 2022 Winter Simulation Conference 
(WSC) with Microsoft Word also serves as a sample file that you can edit to produce your submission, and 
a checklist to ensure that your submission meets the WSC 2022 requirements. Please follow the guidelines 
herein when preparing your paper. Failure to do so may result in a paper being rejected, returned for 
appropriate revision, or edited without your knowledge. 

1 INTRODUCTION 

This paper provides instructions for the preparation of papers for the 2022 Winter Simulation Conference 

(WSC) with Microsoft Word. There is a companion paper that provides instructions for the preparation of 
papers using LaTeX. The easiest way to write a paper using Microsoft Word that complies with the 

requirements is to use the wsc21word.dotx template file. Do not use an older version, as some 
specifications have changed. 
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An author kit is available via the conference website. The author kit includes this Microsoft Word 
document and its LaTeX companion. It also includes guidelines that you may find helpful for writing a 
conference paper and for giving a presentation.  

When preparing your paper in Word, you are required to use the Word template. The easiest way to use 
this template is to copy the template to your working directory and double-click the template from your 
operating system. This will launch Word and will create a new document based on the template.  

A set of styles are defined in the template so that authors can easily achieve the required format. You 
should look carefully at how the styles are applied in this document. One simple way to get started with 
styles is to start with the sample paper and replace the existing text. Do not try to make “manual” formatting 
changes to the text – let styles do the work. For example, instead of manually indenting paragraphs to 
conform to the WSC 2022 specifications, simply apply the corresponding predefined style from Table 1; 
the paper will then meet indenting requirements. To view the styles defined in the template, open the Styles 
Panel by clicking the bottom right corner arrow button in the “Styles” group on the “Home” ribbon in MS 
Word 2010 (please use MS Word help to identify corresponding capabilities in other versions). The Styles 
panel also shows the style currently applied to the text at the current cursor position as the boxed style in 
the list. To apply different formatting, choose the appropriate style from the list. The specific formatting 
instructions for a style may be viewed by placing the cursor over the style of interest. For additional help 
with styles, review the Word Help topic “Style basics in Word.” Avoid updating the styles that are provided; 

the proceedings editors have checked that the formatting provided by the styles is that needed for the WSC.  
Note that some styles appearing in this paper’s styles set are not found in earlier WSC templates nor in 

Table 1 because formatting that is added during the normal editing process will appear in the Style Area 
Panel. The safest way to ensure conformance to formatting requirements is to apply only styles that are 
listed in Table 1. 

2 GENERAL GUIDELINES 

2.1 Language 

The paper should be prepared using U.S. English in the interest of consistency across the proceedings. The 
language can be set in MS Word 2010 via File > Options > Language settings, and selecting “English 
(United States)” from the drop-down menu. 

2.2 Paper Submission 

You will electronically submit the paper in Portable Document Format (.pdf), through the conference 

website. The .pdf file allows for automatic counting of pages and ensures that the page limit has been 
followed. If the paper is accepted, you will electronically submit the word-processor source file (.docx) for 
the final version of your paper. The editors may send the file back to you with the request to make changes 
to conform to conference guidelines. For minor changes, the editors may make the changes themselves. 
Final .pdf files are generated by the conference proceedings editors. 

You will also need to transfer the copyright of your article to the WSC using the copyright transfer 
form that will be available via the conference website at the appropriate time. For your paper to be 
published by the WSC, you must complete the transfer of copyright. When you have successfully transferred 
the copyright, you will receive a .pdf receipt.  

If you are unable to satisfy these requirements, you should contact the proceedings editors. 

2.3 Objectivity 

The content of the paper should be objective and without any appearance of commercialism. In general, 

comparisons of commercial software should be avoided unless they are central to the topic. If a comparison 
of commercial software is included, it should be based on objective analysis that includes criteria, 
description of ranking methodology on each criterion, and the rankings themselves to arrive at a conclusion. 

http://www.wintersim.org/
http://www.wintersim.org/
http://www.wintersim.org/
http://www.wintersim.org/
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If an approach other than a detailed objective analysis is used to select the simulation software used for the 
study being reported, such as, availability of the software, or the familiarity of the analyst with the software, 
it should be clearly identified. 

Table 1: Defined Word styles. 

Style Name Description 

Abstract Heading Heading style for abstract 

Appendices Appendix heading 

AuthorAddress (only for author address block) 

AuthorBio Author biographies 

Definition Definitions, Theorems, and Corollaries 

Equation Equations (without numbers) 

EquationNumbered Equations (with numbers) 

Figure Content Figures 

Figure Label Single-line figure caption 

Figure Label Multiline Multi-line figure caption 

Heading Unnumbered headings – e.g. References, Acknowledgments, Author 
Biographies, etc. 

Heading i Numbered headings for level i headings 

Head …. (Headings and running head styles not intended for author maintenance) 

Hyperlink Hyperlinks (character format, mark only the characters to form the 
hyperlink) 

List Bulleted Bulleted lists 

List enum Numbered lists 

Normal Normal text – no indent – used for first paragraphs after headings 

Normal Indent Normal text – indented – used for all paragraphs following the first for a 
section. 

Program “in-between” lines in a program listing 

ProgramBoth Single-line program statements 

ProgramEnd Last line in a program listing 

ProgramStart First line in a program listing 

Reference References 

Table Label Single-line table caption 

Table Label Multiline Multi-line table captions 

Title Paper title 

2.4 Length Constraints 

2.4.1 Length of the Abstract 

The abstract should be at most 150 words. Since abstracts of all papers accepted for publication in the 
proceedings will also appear in the final program, the length limit of 150 words will be strictly enforced for 

each abstract. The abstract should consist of a single paragraph, and it should not contain references or 
mathematical symbols. Do not include a list of keywords. Keywords are not used in WSC proceedings. 

2.4.2 Length of the Paper 

The page size in the proceedings must be 8.5 inches by 11 inches (21.6 cm by 27.9 cm). The overall length 
of the paper should be at least five proceedings pages. Papers including bibliography and author 
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biography should be at most twelve (12) pages, except for introductory tutorials, advanced tutorials, and 
panel sessions, for which the limit is 15 pages. Exceeding the page limit will result in rejection for the 
proceedings. 

2.5 Font Specification and Spacing 

The paper should be set in the Times New Roman font using an 11-point font size. The paper should have 
a 12.5pt line spacing. Do not use other fonts; use of other fonts means the proceedings editors will need to 

send the paper back to you to change the font. 

2.6 Margins 

All margins are correctly defined in the provided template. Therefore, you should not need to care about 
margins at all, and you may skip this section. Should you have, by accident, destroyed the styles used there, 
please restore the following styles: In the heading of the first page the styles “HeadEditor1” and 
“HeadEditor2” for the first and second line, respectively, and on the other pages the style “HeadAuthor” 
(never more than one line here).  

Just for experts wishing to know the exact configuration, the width of the text area is 6.5 inches 
(16.5 cm). All four margins are 1 inch (2.54 cm) on each page. In this MS Word template, the header and 
footer are set to, respectively, 0.69 inches (1.75 cm) and 0.75 inches (1.90 cm). The heading on the first 
page has no additional margin (effective heading 0.69 inches) while the running head with the authors’ 
names has an additional margin of 0.2 inches (0.51 cm) leading to an effective header position of 0.89 

inches (2.26 cm) for all pages except the first one. The heading on the first page provides an additional 
margin of 0.5 inches (1.27 cm), leading to an effective title position of 1.5 inches (3.81 cm). Authors should 
neither change these header and footer settings nor the corresponding MS word styles when preparing a 
manuscript.  

2.7 Justification 

Headings of sections, subsections, and subsubsections should be left-justified. One-line captions for figures 
or tables should be centered. A multiline caption for a figure or table should be fully justified. All other text 
should be fully justified across the page (that is, the text should line up on the right-hand and left-hand sides 
of the page). 

2.8 Headings of Sections, Subsections, and Subsubsections 

Section, subsection, and subsubsection headings should appear flush left, set in the bold font style, and 
numbered as shown in this document. The headings for the Abstract, Acknowledgments, References and 

Author Biographies sections are not numbered. Section headings should be set in FULL CAPITALS LIKE 

THIS PHRASE, while subsection and subsubsection headings should be Capitalized in Headline Style 

like This Phrase. Lengthy headings should be broken across two or more lines. Again, these formats 

should be accomplished using the styles Heading 1, Heading 2, Heading 3, etc. 

2.8.1 Paragraphs 

The first paragraph after a heading should not be indented; all other paragraphs should be indented by 0.25 
inches (0.63 cm). Do not insert additional space between paragraphs. 

Programming code should use “Program Start,” “Program,” and “Program End” Styles with the 
following guidelines. 

class Exponential{ 

…// Properties of the Exponential 

}; 
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One-line programs should use the “Program Both” style. 
 

Exponential interArrival; 

2.8.2 Footnotes 

Do not use footnotes; instead, incorporate such material into the text directly or parenthetically. 

2.8.3 Page Numbers 

Do not include page numbers. Page numbers are generated by the proceedings editors once all accepted 
papers are ordered for the final proceedings. 

3 FORMATTING THE FIRST PAGE 

3.1 Running Heads 

The running head (provided in the template) in the upper left-hand corner of the first page (which should 
read Proceedings of the 2022 Winter Simulation Conference …) is left-justified and set in the 11-point italic 
font style. You do not have to change the content of the first-page header; the first-page header was set by 
the proceedings editors in the preparation of this document. 

Running heads on the second and subsequent pages should contain the last names of the authors, 
centered and set in the 11-point italic font style. For example, running heads for papers would appear like 
Justme for papers with one author, or Justme and Him for papers with two authors, or Justme, Him, and 
Youtoo for papers with three authors, etc. Separate the last names of the authors with a comma, except for 
the last author use “, and”. List all authors; do not use et al. except if they don’t fit on one line. In the latter 
case, only the first author is given followed by “et al.”.  The author names are listed in the same order as 
they appear on the title page. This will be the same order when providing the author biographies at the end 
of the paper. Once on the second page of your document, view the header and make the appropriate changes. 

3.2 Title and Authors 

Center the title of the paper on the page and set it in bold FULL CAPITALS. Multiline titles should have 
about the same amount of text on each line. There should be two blank lines between the title and the 
authors’ names.  

Each author’s name should be capitalized and centered on a new line, with the author’s first name first 
and no job title or honorific. Insert one blank line between the author’s name and address. The organization 
or institution that the author is affiliated to should be typed first. Next type the complete street address, 
without abbreviations, followed by the city, standard two-letter state or province abbreviation, postal code, 
and country. The address should be centered and capitalized, except for the country, which should be set in 
FULL CAPITALS. If you need to restore the style, select the “AuthorAddress” style. For papers with 
multiple authors, the authors should be listed in order of decreasing contribution. Authors from the same 
institution are grouped in the block of an author with the highest contribution among them. Different 
formats for multiple authors are shown as examples in Figures 3–8 at the end of this document. Sometimes 
you may need to break some authors’ department names into two lines to fit the author block format, as 
shown by this document’s authorship. There should be two blank lines between the author fields and the 
text of the paper. The authors are provided in a table so adding and deleting columns is done via the table 

commands. Do not include email addresses on the first page; emails for authors are provided in the author 
biographies. Authors with multiple affiliations shall pick the primary affiliation for the title page and 
mention other affiliations in their resume.  
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4 FORMATTING SUBSEQUENT PAGES 

Please refer to section 2.6 for the correct margins. 

4.1 Mathematical Expressions in Text and in Displays 

Display only the most important equations, and number only the displayed equations that are explicitly 
referenced in the text. Assign the style "Equation" and add one empty line above and below the equations. 
If two equations are printed in direct sequence, do not add a blank line between them.  

To conserve space, simple mathematical expressions such as  =
−=

n
i iYnY

1
1  may be incorporated into 

the text. Mathematical expressions that are more complicated or that must be referenced later should be 
displayed, as in  
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If an equation is referenced in the text, then enclose the equation number in parentheses and place it 

flush with the right-hand margin of the column. Add a tabulator before and after the equation and use the 
style "EquationNumbered" to get this effect. For example, the quadratic equation has the general form 
 

 
.0where,02 =++ acbxax
 (1) 

 
In the text, each reference to an equation number should also be enclosed in parentheses. For example, 

the solution to (1) is given in (2) in Appendix A. Note that equation numbers are not automatically generated 
or referenced. 

If the equation is at the end of a sentence, then you should end the equation with a period. If the sentence 

in question continues beyond the equation, then you should end the equation with the appropriate 
punctuation – that is, a comma, semicolon, or no punctuation mark. If the equation is not included within 
any sentence, but just given between two paragraphs, no punctuation is used as in equation (2).  
 

 𝑎𝑥2 + 𝑏𝑥 + 𝑐 = 0 (2) 
 

If you are using Microsoft Equation Editor 3.0, select the “EquationNumbered” style on the line where 
the equation will appear. Then press the TAB key to move the cursor to the center of the column. From 
Word’s Insert ribbon, select Object in the Text group. In the pull-down menu that appears, select Object, 
and in the Object panel, select type Microsoft Equation 3.0, and type the equation. While in the Equation 
Editor, you should verify that the font size is at most 11 points. On the Equation Editor’s menu bar, select 
Size > Define, and set the “Full” font size to 11. Close the Equation Editor. To include the equation number, 
press the TAB key. This will move the cursor to the right-hand margin; then type the equation number 
enclosed in parentheses. If you don't need to number the equation, use the "Equation" style and leave out 
the tabs.  

If you are using MathType, click the “Insert Display Equation” button on MathType’s Equation Editor 

menu bar. Before you type the equation, verify that the font size is at most 11 points by choosing Size > 
Define. After typing the equation, close the MathType Equation Editor, press the TAB key to move the 
cursor to the right margin, and type the equation number, if any, enclosed in parentheses. For unnumbered 
equations, MathType users should click the “Insert Display Equation” button. 

Entering equations using the Equation option available in the Symbols group on the Insert tab in 
Microsoft Word 2007 or 2010 is not recommended. For Microsoft Word 2007 or 2010, the equation 
capability makes entering equations quite convenient but numbering them requires using tables. Instructions 
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for inserting equation numbers for Microsoft Word 2007 and 2010 are available online at WordTips (Sharon 
Parq Associates 2018).  

4.2 Displayed Lists 

A displayed list is a list that is set off from the text, as opposed to a run-in list that is incorporated into the 
text. The bulleted list given below provides more information about the format of a displayed list.  

 

• Use the "Lists Bulleted" style that leads to standard bullets instead of checks, arrows, etc., 
1. For numbered lists, use the "List Enum" style with Arabic numbers, 
2. You may need to restart the numbering on numbered lists. To do so, right click on the first entry in 

the list. 
 
Indent the paragraph after the list. Include an empty line before and after the list. 

4.3 Figures and Tables 

Figures and tables should be centered within the text and should not extend beyond the right and left margins 
of the paper. Figures and tables can make use of color since the WSC produces electronic proceedings. 
However, try to select colors that can be differentiated when printing in black and white in consideration 
of people using such printers. Figures and tables are numbered sequentially, but separately, using Arabic 
numerals. All tables and figures should be explicitly referenced in the text and they should not be placed 

before they are referenced. The reference is always written in full (Figure 1), and never abbreviated as in 
“(Fig. 1)”. For figures which can fit next to each other, the author can choose to align them next to each 
other with the figure text centered below each figure and on the same line for both figures. For tables which 
can fit next to each other, the author can next to also choose to align them each other with the table text 
centered above each table and on the same line for both tables. 

To insert a table, use the usual Table option on the Insert ribbon. To center the table, first select the 
table, then right-click and select Table Properties, followed by the Table tab and click the Center button for 
Alignment and the None button for Text wrapping. Each table should appear in the document after the 
paragraph in which the table is first referenced. However, if the table is getting split across pages, it is okay 
to include it after a few paragraphs from its first reference. The table’s single-line captions are centered, 
while multi-line captions are fully justified. This template does not use the Word capabilities to insert table 
captions and, thus, does not use the automatic referencing capabilities of Word. Instead, add the appropriate 

caption above the table and use the “Table Label” style for tables with a single-line caption. Use the “Table 
Label Multiline” style for multiline table captions. The styles include inserting a 12 pt. space above and a 
6 pt. space after the caption. The caption should begin with the word Table, followed by the table number 
and a colon. Captions can be written using normal sentences with full punctuation. All captions should end 
with a period. It is fine to have multiple-sentence captions that help to explain the table. Include one line 
space below the table. See Tables 2 and 3 for examples. 

Table 2: Table captions appear above the table, and if they are longer than one line they are fully justified. 
Captions are written using normal sentences with full punctuation. It is fine to have multiple-sentence 
captions that help to explain the table. 

Creature IQ Diet 

dog 70 Anything 
human 60 ice cream 

dolphin 120 fish fillet 

http://word.tips.net/Pages/T000273_Numbering_Equations.html
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Table 3: Comparison between samples. 

Sample Height (cm) 

Plant one 50 

Plant two 58 

Each figure should appear in the document after the paragraph in which the figure is first referenced. 
However, if the figure is getting split across pages or is leading to an empty space at the bottom of the page, 
it is okay to include it after a few paragraphs from its first reference. Figure captions appear below the 
figure. Single-line captions are centered, while multiline captions are fully justified. This template does not 

use the Word capabilities to insert figure captions and, thus, does not use the automatic referencing 
capabilities of Word. Instead, add the appropriate caption below the figure and use the “Figure Label” style 
to label the figure for a single-line caption. Use the “Figure Label Multiline” style for multiline captions. 
The styles include inserting a 6 pt. space above and a 12 pt. space after the caption. Include one line space 
above the figure. The caption should begin with the word Figure, followed by the figure number and a 
colon. Captions end with a period. See Figures 1 and 2 for examples. 

Paste complete figures as pictures into the document (avoid drawing the picture within Word directly). 
To format the picture, select it and then use the "Figure Content" style. The picture will be formatted 
centered and with one line space above the figure.  

 

Figure 1: An unusual answer to a question. 

 

Figure 2: The area of the square is 64 squares, while that of the rectangle is 65 squares, yet they are made 
of the same pieces! How is this possible? 
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References to tables and figures identified by number are capitalized. Avoid using "in the previous 
table" or "in the figure below", as positions might change in the final formatting. 

Please ensure that the text within figures uses standard fonts and is readable: Arial (recommended), 
Symbol, etc. The minimum font size should be around 9pt (Arial). Remember that you might need larger 
fonts in your original figure if you reduce the size of the figure in your WSC paper to less than 100% (e.g., 
when you insert your figure with a 50% of its original size, your original fonts have to be >=18pt.). This 

applies to all text elements in the figure, including captions of axes, etc.  

4.4 Definitions and Theorems 

Definitions, theorems, propositions, etc. should be formatted like a normal paragraph with boldface heading 
as shown in the examples below. Number these items separately and sequentially. You may choose to 
separately number theorems, propositions, corollaries, etc., as opposed to the example below where 
corollaries and theorems are numbered together. Use the "definition" style, also for theorems and 
corollaries. Do not use a period after the definition, theorem, corollary or proposition number, but do end 
the sentence with a period. 
 

Definition 1 In colloquial New Zealand English, the term dopey mongrel is used to refer to someone who 
has exhibited less than stellar intelligence. 

 

Theorem 1 If a proceedings editor from New Zealand accidentally deletes his draft of the author kit shortly 
after completing it, he would be considered to be a dopey mongrel. 

 

Corollary 2 One of the proceedings editors is a dopey mongrel. 

 

Indent the paragraph after the definition or theorem. Include an empty line before and after the item. 

4.5 Hyperlinks 

A hyperlink specifies a Web address (URL) or an e-mail address. The use of hyperlinks allows authors for 
providing readers access to external electronic information, such as a dynamic simulation or animation. 
While the use of hyperlinked text is encouraged in the main body of the paper, it is recommended 

that corresponding Web addresses and other identifying information should be provided in the list 

of references. For example, instead of spelling out the Web address of the conference website, one would 
refer to the conference website and the corresponding entry in the reference section will spell out the 
associated Web address and other relevant information such as author(s) and/or organization that published 
the content. This would allow readers for searching for the content using the author(s), organization, etc. if 
the actual Web address is changed. This also allows for a cleaner appearance of the main body of the paper. 

If the author(s) feel that sufficient information is provided in the main body of the paper to locate the 
content even if the Web address is changed, the address can be included in the main body of the paper itself. 

Each hyperlink should be set in the same font as the text. Hyperlinks are not underlined. A live 
hyperlink (or hot link) – that is, a hyperlink that will activate your Web browser and take it to an external 
website or that will activate your e-mail software for sending a message to a specific e-mail address – should 
be colored blue. You can see examples of such hyperlinks in this paper. The use of live hyperlinks is at the 
discretion of the author(s), except in the author biographies. 

Using live hyperlinks requires the format defined in the “Hyperlink” style. To insert a live hyperlink 
into a WSC paper, please follow the following steps: 

 
1. In the current paragraph style, enter the text where the live hyperlink is to appear. 

http://www.wintersim.org/
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2. With the displayed text selected, choose Insert > Hyperlink from the ribbon or right-click and select 
“Hyperlink.” 

3. In the dialog box that appears, select the button labeled “Existing File or Web Page” or “E-mail 
address.”  

4. In the second box labeled “Address” type only the correct e-mail or Web address, with the prefix 
http:// for a Web address. 

5. If not done automatically, select the displayed text of the live hyperlink and apply the “Hyperlink” 
style. 

6. For hyperlinks with Web addresses, enter an appropriate citation following the text and provide the 
Web address and other relevant information in the corresponding entry in the list of references. 

 
If any editing is made to the displayed text of a live hyperlink, then the “Address” box referred to above 

should be rechecked to ensure no extraneous characters have been introduced into that box. To check the 
“Address” box for accuracy, place the cursor anywhere in the displayed text of the hyperlink and right-
click. Select “Edit Hyperlink.” If extraneous characters have been introduced, delete them from the 
“Address” box. 

If it is necessary to break the displayed text of the e-mail or Web address across two or more lines, then 
you can “edit the hyperlink” in MS Word. There are two fields, one for the original hyperlink and the other 

one for the display, where you can add spaces or soft breaks without influencing the actual link.  
Non-live hyperlinks – that is, the hyperlinks that are included for the reader’s information but do not 

actually invoke the reader’s Web browser or e-mail software – should be colored black.  

4.6 Citing a Reference 

To cite a reference in the text, use the author-date method. Thus, Chien (1989) could also be cited 
parenthetically (Chien 1989). Do not use a comma within this parenthesis. For a work by three or more 
authors, use an abbreviated form. For example, a work by Banks, Carson, and Nelson would be cited in one 
of the following ways: Banks et al. (2000) or (Banks et al. 2000).  

Parenthetical citations are enclosed in parentheses ( ), not square brackets [ ]. Semicolons separate the 
items in a series of such citations.  

The following is a list of correct forms of citations: 
 

• Brown and Edwards (1993) 
• (Brown and Edwards 1993) 
• (Smith 1987; Brown and Edwards 1992; Brown et al. 1995) 

 
The following is a list of incorrect forms of citations: 
 
• Brown and Edwards [1993] 
• (Brown and Edwards, 1993) 
• (Smith, 1987; Brown and Edwards, 1993) 
• (Smith 1987, Arnold, Brown and Edwards 1992, Brown et al. 1995) 
 

4.7 General Style and Sequence of References 

Place the list of references after the appendices. The section heading is REFERENCES, and is not 
numbered (use style "heading"). List all references that are cited in the text, but only those. The only 
exception are papers in the “tutorial” tracks: Here it is permitted to have an additional section heading 
ADDITIONAL READING after references, followed by further literature that is recommended for 
continued studies but not directly used within the text of the paper.  
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Use hanging indentation to distinguish individual entries (use the style "Reference"). Do not insert 
additional space between references. References have a reduced font of 9 pt and a line spacing of 10.5 pt. 
Do not number the references and arrange them in the following order: 

 
• By the last name of the first author 
• For papers with the same first author, arrange first all papers by this author only, then all papers by 

this author and one co-author, and finally all papers with this author and two or more co- authors 
• Within this sorting sequence, arrange papers by year  
 
To identify multiple references by the same authors and year, append a lower case letter to the year of 

publication, for example, 1984a and 1984b. The same applies to references that have more than two authors 
and the same first author and year.  

Give complete references without abbreviations. Even for more than three authors, list all authors.  
The following sections specify the requested content for several types of references. Examples can be 

found in the references and additional reading sections, which include: 
 

• A technical report (Chien 1989) 
• A proceedings article with book publication (Cheng 1994) 
• A conference contribution without book publication (Rabe et al. 2017) 
• A journal article with two authors (Powell and Mustafee 2017) 
• A journal article with more than two authors (Gupta et al. 1973) 
• A book by two (2) authors (Hammersley and Handscomb 1964) 

• A chapter in a book (Schruben 1979) 
• An unpublished thesis or dissertation (Steiger 1999) 
• A book with no identified authors (The University of Chicago Press 2010) 
• A document available on the Web (WSC 2022) 

4.8 Formatting References according to their Type of Publication 

4.8.1 Journal Articles 

The bibliographic style for a journal article is: <Surname of first author>, <Author’s initial(s)>, <Initials 
and surnames of other authors>. <year>. <Capitalized article title in quotes>. <Journal Name in Headline 
Italics> <Volume number>(issue number):<page numbers>. 
 
Gupta, S. S., K. Nagel, and S. Panchapakesan. 1973. “On the Order Statistics from Equally Correlated Normal Random Variables”. 

Biometrika 60(2):403–413. 

Powell, J. H., and N. Mustafee. 2017. "Widening Requirements Capture with Soft Methods: An Investigation of Hybrid M&S 
Studies in Healthcare". Journal of the Operational Research Society 68(10):1211-1222. 

4.8.2 Books 

The bibliographic style for books is: <Surname of first author>, <Author’s initial(s)>, <Initials and 

surnames of other authors>. <year>. <Book Name in Headline Italics>. [<edition> ed. ]<city of 
publication>: <publisher>.  
 
Banks, J., J. S. Carson, B. L. Nelson, and D. M. Nicol. 2000. Discrete-Event System Simulation. 3rd ed. Upper Saddle River, New 

Jersey: Prentice-Hall, Inc. 

Hammersley, J. M., and D. C. Handscomb. 1964. Monte Carlo Methods. London: Methuen. 

Law, A. M., and W. D. Kelton. 2000. Simulation Modeling & Analysis. 3rd ed. New York: McGraw-Hill, Inc. 
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4.8.3 Book Contributions 

The bibliographic style for book contributions is: <Surname of first author>, <Author’s initial(s)>, <Initials 
and surnames of other authors>. <year>. <Capitalized article title in quotes>. In <Book Name in Headline 
Italics>, edited by <Initials and surnames of editors>, <page numbers>. <city of publication>: <publisher>. 
Publishers are not abbreviated (“IEEE”, “ASIM”), but written in full (“Institute of Electrical and Electronics 
Engineers, Inc.”, “Arbeitsgemeinschaft Simulation”, etc.). Note that WSC papers are published by Institute 

of Electrical and Electronics Engineers, Inc. in Piscataway, New Jersey. Table 4 provides a list of former 
editors of WSC from 2010 to 2020.  
 
Cheng, R. C. H. 1994. “Selecting Input Models”. In Proceedings of the 1994 Winter Simulation Conference, edited by J. D. Tew, 

M. Manivannan, D. A. Sadowski, and A. F. Seila, 184–191. Piscataway, New Jersey: Institute of Electrical and Electronics 

Engineers, Inc.  

Schruben, L. W. 1979. “Designing Correlation Induction Strategies for Simulation Experiments”. In Current Issues in Computer 

Simulation, edited by N. R. Adam and A. Dogramaci, 235–256. New York: Academic Press. 

4.8.4 Conferences 

For conferences that have been published as an (electronic) book publication (with editors, publisher, 
ISBN), use the same style as for book contributions (take care to specify the city of publication, not the 
conference location!). This especially applies to past WSC proceedings, such as (Cheng 1994). See the 
example under “book contributions” for this purpose.  

For conferences that have not been published as a book, the bibliographical style is: <Surname of first 
author>, <Author’s initial(s)>, <Initials and surnames of other authors>. <year>. <Capitalized article title 
in quotes>. <Conference Name in Headline Italics>, <full date(s) of conference>, <location of conference>, 
<page numbers if available>. 
 
Rabe, M., F. Dross, and A. Wuttke. 2017. “Combining a Discrete-event Simulation Model of a Logistics Network with Deep 

Reinforcement Learning”. In Proceedings of the MIC and MAEB 2017 Conferences, July 4th-7th, Barcelona, Spain, 765-774.  

4.8.5 Handbooks, Reports, and other Publications 

If you need to cite handbooks or other publications that have editors but no authors, use the following 
bibliographic style: <Surname of first editor>, <Editor’s initial(s)>, <Initials and surnames of other 
editors>, Editors. <year>. <Book Name in Headline Italics>. <city of publication>: <publisher>. 

If you need to cite reports, use the following bibliographic style: <Surname of first author>, <Author’s 
initial(s)>, <Initials and surnames of other authors>. <year>. <Capitalized article title in quotes>. [Report 
number], <publisher>. 
 
Chien, C. 1989. “Small Sample Theory for Steady State Confidence Intervals”. Technical Report No. 37, Department of Operations 

Research, Stanford University, Stanford, California. 

 
If you need to cite government documents without authors’ names, use the following bibliographic 

style: <Name of government agency>. <year>. <Capitalized document title in quotes>. [Report number], 
<publisher>. 
 
Ontario Ministry of Health. 1994. “Selected Findings from the Mental Health Supplement of the Ontario Health Survey”. Queen’s 

Printer for Ontario.  
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4.8.6 Online Publications 

For publications that are only WWW pages, if there is no way to avoid them, use the best fitting style from 
the categories above and add the URL and the date when you accessed the page without the year: 
 
Sharon Parq Associates. 2018. WordTips: Numbering Equations. http://word.tips.net/Pages/T000273_Numbering_Equations.html, 

accessed 15th April.  

 
If you just refer to a document from the WWW that has a clear publication date, the citation year is this 

date and the year of access must be given: 
 

Steiger, N. M. 1999. Improved Batching for Confidence Interval Construction in Steady-State Simulation. Ph.D. thesis, Department 

of Industrial Engineering, North Carolina State University, Raleigh, North Carolina. 
http://www.lib.ncsu.edu/resolver/1840.16/4713, accessed 12th February 2019.  

 

If you refer to an archival reference (e.g., an unpublished manuscript), it should not have any published 
version. 

ACKNOWLEDGMENTS 

Place the acknowledgments section, if needed, after the main text, but before any appendices and the 
references. The section heading is not numbered. These instructions are adapted from instructions that have 
been iteratively updated and improved by proceedings editors and several other individuals, who are too 
numerous to name separately, since the first set of instructions were written by Barry Nelson for the 1991 
WSC. 

A APPENDICES 

Place any appendices after the acknowledgments and label them A, B, C, and so forth.  
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B GETTING HELP 

If you need help in preparing your paper, contact the proceedings editors. You can reach us individually 
using the contact information below: 

 
Ben Feng (lead editor) 
University of Waterloo 
E-Mail: ben.feng@uwaterloo.ca 

 

Giulia Pedrielli 
Arizona State University 
E-Mail: giulia.pedrielli@asu.edu 

Yijie Peng 
Peking University 
E-Mail: pengyijie@pku.edu.cn 

Sara Shashaani 
North Carolina State University 
E-Mail: sshasha2@ncsu.edu 
 

Eunhye Song 
Pennsylvania State University 
E-Mail: eus358@psu.edu 

Canan Gunes Corlu 
Boston University 
Email: canan@bu.edu 
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C AUTHORS’ CHECKLIST 

We strive for a consistent appearance in all papers published in the proceedings. If you have used the 
template and styles within this author’s kit, then almost all of the requirements in this checklist will be 
automatically satisfied, and there is very little to check. Please print a hardcopy of your paper, and go 
over your printed paper to make sure it adheres to the following requirements. Thank you! 

 

1. The paper can be at most 12 pages long (15 for tutorials and panel sessions). Longer papers cannot 
be published; the minimum number of pages is 5 pages. 

2. No keywords, footnotes or page numbers. 
3. The paper has been spellchecked using U.S. English. 
4. The paper title is in bold and in ALL CAPS. Please use the template to use correct indents and 

spaces. 
5. The abstract must have 150 or fewer words. 
6. Double-check that the author section after the title is formatted correctly: the number of organiza-

tions defines the number of blocks, and the number of blocks defines the layout. Country names 
are in ALL CAPS. 

7. Use the correct running heads! Use the proceedings editors and chairs on page one, and use the last 
names of authors separated by commas for the other pages. Do not forget that the last “Last Name” 

is preceded by “and ” (also with a comma if more than two authors).  
8. Section titles are in bold and ALL CAPS, subsections capitalize the first letter of important words. 

Please use the templates to use correct indents and spaces and make sure to left-justify. Section 
titles are numbered, except for the abstract, acknowledgements, references and author biographies. 

9. The first line of each paragraph is indented, except for the first paragraph of a section or subsection. 
10. There should be extra lines before and after enumerations, lists, definitions, etc. 
11. Citations are by author and year; citations are enclosed in parentheses, not brackets.  
12. References are in the hangref style with a 9pt font, listed alphabetically by the last names(s) of the 

author(s), 
13. Double-check that figures and tables are referenced in the text and have the correct caption format! 

Table captions appear above the table. Figure captions appear below the figure. All text in figures 
and tables is readable (minimum final print font using Arial could be 8pt, for Times 9pt). 

14. Verify that equations are centered and that all equation numbers are in parentheses and right-
justified. 

15. Ensure that hyperlinks will work as of the date of December  2022. Live hyperlinks are blue, non-
live hyperlinks are black.  

16. Don’t forget the “author biographies” section! Author biographies must be one paragraph per 
author and must include an email address.  

The following items should work automatically if you are using the WSC 2022 template, but you are 
encouraged to double-check, especially if you copy and paste any text from other documents: 

1. Paper is letter format (8.5’’ x 11’’, or 216 mm x 279 mm), not DIN A4 format. Please use the required 
margins as defined in section 2.6.  

2. All text is in 11-Point Times New Roman with a line spacing of 12.5pt, except references and 
author biographies, which are 2pts smaller in size and spacing 
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AUTHOR BIOGRAPHIES 

Author biographies are mandatory for all authors and given in the same sequence as in the running head. 
Use a smaller font (9 pt) with a 10.5pt line spacing (MS Word style AuthorBio). Giving an email address 
is mandatory and the author’s name is set in bold capitals (see the examples below). Separate the authors 
by an empty line with the same style. Give only one paragraph per author, but sufficient information to 
understand the author’s position and scientific background.  
 

BEN MINGBIN FENG is an Assistant Professor in actuarial science at the University of Waterloo. He earned his Ph.D. in the 

Department of Industrial Engineering and Management Sciences at Northwestern University. He is an Associate of the Society of 

Actuaries (ASA). His research interests include stochastic simulation design and analysis, optimization via simulation, nonlinear 
optimization, and financial and actuarial applications of simulation and optimization methodologies. His e-mail address is 

ben.feng@uwaterloo.ca. His website is http://www.math.uwaterloo.ca/~mbfeng/.  

 

GIULIA PEDRIELLI is an Assistant Professor in the School of Computing and Augmented Intelligence at the Arizona State 
University. She holds a Ph.D. degree in Mechanical Engineering from the Politecnico di Milano. Her research interest include 

global optimization, random algorithms, applied to engineering applications including manufacturing, cyber-physical systems, and 

computational biology. She is a member of IEEE and INFORMS. Her email address is giulia.pedrielli@asu.edu. Her website is 

https://www.gpedriel.com/. 
 

YIJIE PENG is an Associate Professor in Guanghua School of Management at Peking University. His research interests include 

stochastic modeling and analysis, simulation optimization, machine learning, data analytics, and healthcare. He is a member of 

INFORMS and IEEE, and serves as an Associate Editor of the Asia-Pacific Journal of Operational Research and  the Conference 
Editorial Board of the IEEE Control Systems Society. His email address is  pengyijie@pku.edu.cn. 

 

SARA SHASHAANI is an Assistant Professor in the Edward P. Fitts Department of Industrial and System Engineering at North 

Carolina State University. Her research interests are analysis and design of probabilistic data-driven models and Monte Carlo 
Simulation Optimization. She has been serving on the INFORMS-Simulation Diversity committee since 2019. Her email address 

is sshasha2@ncsu.edu and her homepage is https://shashaani.wordpress.ncsu.edu/ 

 

EUNHYE SONG is a Harold and Inge Marcus Early Career Assistant Professor in the Department of Industrial and Manufacturing 
Engineering at Penn State University. She earned her PhD degree in Industrial Engineering and Management Sciences at 

Northwestern University in 2017. Her research interests include simulation design of experiments, uncertainty and risk 

quantification, and simulation optimization. Her email address is eus358@psu.edu and her website can be found at 

http://eunhyesong.info. 
 

CANAN GUNES CORLU is an Associate Professor in the Administrative Sciences Department of Metropolitan College at Boston 
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University. Her primary research interest is in the area of design and analysis of stochastic simulations under input uncertainty and 

applications of data analytics and simulation-based optimization in operations management and supply chain management, 
including computational transportation and logistics. She also utilizes simulation to address problems in manufacturing and service 

supply chains. She is serving as the treasurer of the INFORMS Simulation Society since 2020. She is an associate editor for the 

Journal of Simulation. Her email address is canan@bu.edu and her homepage is https://www.bu.edu/met/profile/canan-gunes-

corlu/ 
 

AUTHOR BLOCK TEMPLATES (TITLE PAGE) 

First Name Last Name 1 
[First Name Last Name 2] 

[First Name Last Name 3] 
 

Institution 
Street Address line 1 
Street Address line 2 

City, ST Zip, COUNTRY 

Figure 3: Example title page heading with author(s) from one single institution. Each author name has its 
own line.  

 
First Name Last Name 1 First Name Last Name 2 

[First Name Last Name 3] [First Name Last Name 4] 
  

Institution 1 Institution 2 
Street Address line 1 Street Address line 1 
Street Address line 2 Street Address line 2 

City, ST Zip, COUNTRY City, ST Zip, COUNTRY 

Figure 4: Example title page heading with authors from two different institutions. Each author name is 
entered in a separate line. If you have more authors from one institution, then please add blank table cells 
to align the institutions on the same line.  
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Institution 1 Institution 2 

Street Address line 1 Street Address line 1 

Street Address line 2 Street Address line 2 
City, ST Zip, COUNTRY City, ST Zip, COUNTRY 

 
 

First Name Last Name 3 
 

Institution 3 
Street Address line 1 
Street Address line 2 

City, ST Zip, COUNTRY 

Figure 5: Example title page heading with authors from three different institutions. Note that there are two 
empty rows between the institutions. For additional authors from these institutions compare Figure 4. 
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Street Address line 2 Street Address line 2 
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First Name Last Name 3 First Name Last Name 4 
  

Institution 3 Institution 4 
Street Address line 1 Street Address line 1 
Street Address line 2 Street Address line 2 

City, ST Zip, COUNTRY City, ST Zip, COUNTRY 

Figure 6: Example title page heading with authors from four different institutions. Note that there are two 
empty rows between the institutions. For additional authors from these institutions compare Figure 4. 
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Institution 1 Institution 2 
Street Address line 1 Street Address line 1 
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Street Address line 2 Street Address line 2 
City, ST Zip, COUNTRY City, ST Zip, COUNTRY 
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Institution 5 
Street Address line 1 
Street Address line 2 

City, ST Zip, COUNTRY 

Figure 7: Example title page heading with authors from five different institutions. Note that there are two 
empty rows between the institutions. For additional authors from these institutions compare Figure 4. 
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Institution 1 Institution 2 

Street Address line 1 Street Address line 1 
Street Address line 2 Street Address line 2 
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Street Address line 1 Street Address line 1 
Street Address line 2 Street Address line 2 

City, ST Zip, COUNTRY City, ST Zip, COUNTRY 
  
  

First Name Last Name 5 First Name Last Name 6 

  
Institution 5 Institution 6 
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Street Address line 2 Street Address line 2 

City, ST Zip, COUNTRY City, ST Zip, COUNTRY 

Figure 8: Example title page heading with authors from six different institutions. Note that there are two 
empty rows between the institutions. For additional authors from these institutions compare Figure 4. 

  



LastName1, LastName2, LastName3, LastName4, and LastName5 (LastAuthor) 
 

 

LIST OF WSC EDITORS 

Table 4: Editors from 2010 to 2022. 

Year Editors 

2022 Ben Feng, Giulia Pedrielli, Yijie Peng, Sara Shashaani, Eunhye Song, Canan Gunes Corlu, 

Loo Hay Lee, Ek Peng Chew, Theresa Roeder, and Peter Lendermann 

2021 Sojung Kim, Ben Feng, Katy Smith, Sara Masoud, Zeyu Zheng, Claudia Szabo, and Margaret 
Loper 

2020 Ki-Hwan G. Bae, Ben Feng, Sojung Kim, Sanja Lazarova-Molnar, Zeyu Zheng, Theresa 
Roeder, and Renee Thiesing 

2019 Navonil Mustafee, Ki-Hwan G. Bae, Sanja Lazarova-Molnar, Markus Rabe, C. Szabo, Peter 
Haas, and Young-Jun Son 

2018 Markus Rabe, Angel A. Juan, Navonil Mustafee, Anders Skoogh, Sanjay Jain, and Björn 

Johansson 

2017 Victor W.K. Chan,  Andrea D’Ambrogio,  Gregory Zacharewicz, Navonil Mustafee, Gabriel 
Wainer, and Ernest H. Page 

2016 Theresa M.K. Roeder, Peter I. Frazier, Robert Szechtman, Enlu Zhou, Todd Huschka, and 
Stephen E. Chick 

2015 Levent Yilmaz, Victor W.K. Chan, Il-Chul Moon, Theresa M.K. Roeder, Charles Macal, and 
Manuel D. Rossetti 

2014 Andreas Tolk, Saikou Y. Diallo, Ilya O. Ryzhov, Levent Yilmaz, Stephen J. Buckley, and 

John A. Miller 

2013 Raghu Pasupathy, Seong-He Kim, Andreas Tolk, Raymond R. Hill, and Michael E. Kuhl 

2012 Christoph Laroque, Jan Himmelspach, Raghu Pasupathy, Oliver Rose, and Adelinde M. 
Uhrmacher 

2011 Sanjay Jain, Roy R. Creasey, Jan Himmelspach, Preston K. White, and Michael C. Fu 

2010 Björn Johansson, Sanjay Jain, Jairo R. Montoya-Torres, J. Hugan, and Enver Yücesan 

 


